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Hello, this is Eric Bobrow, and in this lesson we'll be looking at the Layout Book where we create layout
sheets for printing out our construction documents. We'll also explore how you place the views that
we've been working on as drawings onto these sheets. [00:17]

So we've been looking in the View Map of most of the time here in the Navigator, and I'm going to
switch to the Layout Book. Now the Layout Book has a series of sheets. These are indicated by the icon
that looks like this, a piece of paper with a tiny little area for the title block. So that's the icon forit. If |
double click on say for example, this one that is the first floor plan, which would be the ground floor in
international vernacular, and then Fit in Window, you can see the floor plan that | had worked on with
the dimensions that | had placed up to this point. [00:56]

Now as | look at these, you can see this has a number, A-101, and it has a name, "First Floor Plan". When
| highlight it, | can change the name down here, and | could also change the number in the properties
down below. However, you'll notice that this is A-101, and this is A-102. These are automatically being
numbered by what is called the subset, which is this folder type of icon. But the folder has a little
number embedded in it to let you know that it's not just a folder, it's a folder that does numbering. Now
I’m going to go and open up the settings for this folder, you see it says, "A-1 Plans". And we'll look at
the settings for the subsets. So the subsets are groups of layouts, and in this case, the group here is
called "Plans". You'll also notice on the right here that there's one called Elevations and Sections with
different numbers. [1:57]

And it says that it's going to put a certain prefix here that will start. So A-1. And then it's going to
number all of the sheets within it with a sequence starting with 1, but using two digits: 01, 02, etc. So
this is something that we won't spend that much time right now on, but know that you can change the
numbering to letters or single digits or multiple digits; and you can change the prefix here from an
automatic one that comes from the Layout Book. In other words, A-1 comes from the fact that this is the
first group after the cover sheet, and each one of these is automatic. Or we can manually go and change
this to a certain number. So for example, if | said A-22, then you'll see down below, we've got some
numbers being added in here. [2:54]

So that actually added it to the A-1. If | took this off, you can see | can put in whatever number | want. I'l
just put in A-9, and you can see how that adjusts. So, play around with this, get comfortable with it, but
mainly I'll just cancel it. Because really what | want to do is just have it back to where it automatically
gets picked up from the fact that this is the first group. Now, the numbering here, if | create a new



layout by right clicking say on one of these layouts, | can say, "Create New Layout". And you'll see that it
gives me the option of naming it. So I'll just call it "New Layout". And then it will pick up by default the
automatic ID, the numbering, from its position in the sequence. And it will also use what's called a
Master Layout, which we'll be exploring a minute, but that determines the size of the sheet and the
general arrangement of it. [3:49]

So I'll just say Create. And you can see how "New Layout" here appears. And it's automatically been
numbered "A-103". If | drag this up higher in the list and reposition it, you'll see it becomes A-102 and
what was previously the second floor or upper floor plan renumbers. So, these will automatically
number in a very convenient way. Now you can have these groups for plans, elevations and sections; or
you can have one long list, perhaps in a simpler project, where you just say the first sheet is this, this
second sheet is that, and just keep numbering it 5, 6, 7, 8, 9 through whatever number of sheets you
need. [4:28]

Now once I've got a layout on here, if | do want to get rid of it, then | can use the little "X" in this area, or
right click and say Delete. And it will warn me that | can't undo it, but that's fine, | want to get rid of this
one that | just created. So let's take a look at what the information is that is on the sheet in addition to
the drawing. You'll see that the drawing is shown right now in black, and there's this stuff over to the
side that's in red. Now it will look different if you're in the international version, because | know that the
title block information is a different format, but the idea is that some things are on each individual
sheet. For example, if | switch to the second floor plan, you'll see that has a different drawing, but the
sheet looks similar. But you'll also notice that down below it says A-102, whereas previously, | was on a
sheet A-101. So there's information that changes and other information that's constant. [5:30]

This layout here has a master. When | press down on it, there's a choice. It's a little off the recording
screen, but basically | can choose what master it's going to use as a background. To see how these
masters are organized, I'll scroll down in the Layout Book and you see there's a folder called "Masters". |
will open by clicking the triangle, and then | will look at the one that is called "Arch-D". So that is a sheet
in the U.S., 24x36 inches, it sort of a medium size full architectural sheet. 2x3 foot, so that would be |
guess 600x900 mm. And so I'm going to double click on that, and you'll see that it brings up another
view, this time with no drawing. And this time with the information on the side in black. And what that
means | can actually edit that information here. [6:27]

So let's say that we want to start adding some information about the design firm, whatever firm you are
working in to this area. So I'll go and place my logo. So I'll go to the File menu, and I'll go to External
Content, Place External Drawing. Now this command is available in ArchiCAD 10 and up. But, if you're
in the Start Edition, you may not be able to use this command for what I'm doing, and you would need
to use a different command called the Figure tool. But let proceed with this one here. I'm going to go
and search for my logo. So BCG is my company initials, and I'm going to look for BCG Logo as a filename.
Now you can just go navigate manually to where you know you have your logo, but I'm just going to
quickly ask the operating system, the Mac, to find my logo for me. So here, it's found it. It's a JPEG, file,
so that's a simple graphic file, and I'll just say, "Open" it. [7:31]



So this allows me to get JPEGs as well GIFS or PDFs, a variety of different types of drawings are available.
Now when | move back into this area, | can click. And you see that as | place it, well, it's a little bit too
big. So I'll just double click on the minus to zoom out a little bit, and I'll resize it. So I'll go to the Arrow
tool, click once on its corner, and then I'll press down here and use the option in the Editing palette, or
the pet palette, to stretch it. And you'll notice that it keeps the proportions, so the diagonal line is the
same. And | can resize it until | think it's about what fill fit, and then tweak it afterward. [8:18]

| will just zoom in a little bit so | can see it better, and I'll grab this center point, and just move the whole
thing into position. And that's still a little bit too big, so I'll go and grab, in this case the bottom right
corner, and again, I'll need to tell it to stretch. Sometimes you need to tell the pet palette again what
you want. So that fits in nicely. Now you'll see down below there is this thing saying, "BCG Company
Logo". That is the automatic title that came in, because the default settings for drawing - and this is
considered a drawing, even though it's just a logo - the default settings were to put a title underneath,
just like we might have a ground floor plan or north elevation as a title underneath a drawing. [9:06]

Now, I've got this selected. It still has handles on it, and | can scroll over in the info box until we see the
drawing. It's actually way over to the right. And you'll see it says "Built-In Drawing Title". Now this may
look different in whatever version of ArchiCAD you have, but let's just look. If | switch it to "NCS
Drawing Title", that's one of the ones in the U.S. for National Cad Standards. And you'll see how it
switches. Of course this would be a nice one for many types of plan or elevation or detail drawings. It
automatically shows the scale. Of course, I've scaled this arbitrarily, but normally it would show a known
building scale. Now in this case, | don't really want a title, because this is just a graphic. It doesn't need
to have a title below it. So I'll turn it off with no title. [9:55]

Now, you'll notice that there's a line underneath here. There's actually a boundary line around all of it
that will not print. This is controllable if you want to see it better by going to the View menu, Onscreen
View Options. And you can temporarily or for as long as you wish turn off the Drawing Frames. You'll
notice the check box next to it, I'll click on that, and you can see now that's turned off. So if | just go
back to, for example, the floor plan sheet, you'll see that now we don't see the boundary of the sheet.
But when I click on it, the drawing has a boundary. Now, you'll notice that up in the upper right corner
already the information that | put on the master has appeared. So whatever | put onto a master will
show up on each and every sheet that uses that master. [10:48]

Now I'm going to go and say Fit in Window here, and I'll go and crop this. Because really, | don't need
the title to be way down below here. | don't need to be showing these little symbols which are in the
U.S. version, the elevation markers showing where the elevations are. Now | could move those markets
closer to the building, but | don't even need to show them, | can just say front elevation is on this sheet,
or if I don't need to necessarily have an indicator marker on this drawing. So I'll go to a corner, and
instead of using the stretch one, which would resize; I'll just demonstrate if | do that. You can see how it
makes it much smaller but now it's not a known scale, it's an arbitrary scale. [11:34]

Let me undo that. I'll use the pet palette, and I'll pick the option in the upper left row of the top row.
And this will adjust the polygon outline which will essentially crop the boundary of the frame. And you



can see how that easily takes place. Now | want to move this up into the upper left corner to make
room for more drawings on the sheet, so | press down. Now if | move, if | use option in the upper part,
this is to move the sub-element. Which means the drawing within the frame. Not what | want to do
right now, but I'll just show you. If | click, it's moved it behind this invisible frame, and it's essentially
hiding some of it. Sometimes you'll want to create a frame at fits right into a certain space, and then
adjust the drawing as well as you can to fit into that space. But in this case | will undo that, because |
want it to show the whole thing. [12:30]

And instead, I'll use the option in the pet palette that says | want to move the whole thing. This is the
bottom left option to move the whole thing over, and you can see how | can disposition it here. So that
is a good position for that. Now the second floor plan would probably fit nicely on here, so the upper
floor. So what I'm going to do is actually open up the triangle in the Navigator to see the second floor
plan. And I'll drag this icon for the second floor plan onto the sheet. And you'll see as soon as | do that,
it appears on the sheet, maybe not neatly placed, but in whatever position it was on the other sheet. So
| can go and select this, and again | can go and crop it here, using the pet palette. [13:22]

And | can't quite see how far it should look there, so I'll just move it over in space. And I'll use the option
to move by clicking within it and using that option there. And then crop it a little further using the pet
palette to say, this that | don't want to move, | want to crop it. And if the pet palette gets in your way,
you can always grab its title bar and move it. And so let me get it to a good position. And then I'll go and
move it this time. Again, press the middle, use the bottom option and reposition here. [13:59]

Now if | want to line things up so that they are in alignment, then what we can do, I'll just zoom in a little
bit on this. | can go, for example, click on this corner here. So when I'm pressing down on this corner, I'm
moving the drawing from that snap point. And then | can move it around arbitrarily, but what | might
want to do is just move it up or down by pressing the Shift key. So if | press the Shift key, having
gestured let's say vertically, then | can move my mouse anywhere | want. And I'll just go and a snap
point. You'll notice how the cursor changes from an arrow to an arrow with a check mark. And | click on
that. And that has made this corner line up with that corner to make them neatly arranged. And I'll go
back and Fit in Window here. [14:53]

So let me drag on a couple of other drawings here. So right now I've just repositioned or moved around
one drawing, and brought another drawing from a different sheet onto here. And what I'll do is I'll go to
the View Map. So | click in the Navigator on the View Map. And let's say that we want to bring in the
Furniture plan. So I'll just highlight or press down on the Furniture plan in the View Map, and just drag it.
And you see this little plus sign that will place the actual drawing. It looks like I'm dragging an icon, but
when | let go, it will place the drawing. And you can see how that neatly has positioned itself. I'll move
this over, into a nice position here, and perhaps crop it a little bit tighter so if fits better. [15:44]

So we can of course line this up, | won't bother with doing that. Or maybe I'll quickly gather it from this
corner, move it to the left, press the Shift key, that locks me in. And again, I'll just go and snap to a point.
| may need to zoom in a little bit to make sure that I'm snapping to the right point, and then | can know
that those are neatly arranged on there. So we'll get one more drawing, which would be the Ceiling plan



that | was working on. So | need to switch back in the Navigator to the Ceiling plan here. And so I'll just

grab the first floor or ground floor Ceiling plan and put that into position. And then just grab it and move
it. Soifit's not selected, and | just press down and drag with the mouse, it will move immediately. If it is
selected, then | may need to just double check that I'm in the "Move" rather than drag the sub-element,
the drawing within the frame to get it into the right relationship. [16:50]

So | can handle it that way. So one thing that happened just a minute ago that | didn't highlight here is
that | had accidentally clicked in space. And you see when | click in space, it starts to draw a selection
rectangle. And | didn't notice that | had done that, and | started to try to do something in the Layout
Book, and it was ignoring me. In other words, | was clicking here and nothing was happening. So this
has happened to me enough times by accident that | was aware of it. | basically went back into this area
in the Layout environment, and could see that there was this little dark gray box being drawn. And |
simply clicked again to finish it. So now | can switch between these. So if you find that clicking in the
Navigator isn't doing anything, then maybe you need to cancel the operation. Perhaps the click that was
starting to draw a selection. You could hit the Esc key, or you could go back and just click in that space.
[18:00]

Now let's look at some more customization that we can do in the Layout Book. For one thing, if | double
click on this sheet here, the second floor plan; it's no longer needed, because I've taken all the drawings
off of it. So I'll just use the Delete key again, or the Delete button, and say Delete that particular one.
Now, let's look at the master that we've got. And again, I'll scroll back down and double click on the
Master “Arch D.” And you can see here's where we've got what I'd started to draw. And let's just say
that | want to put in some text. So we're going to go to the Text tool. | can go certainly and make this a
little bigger, perhaps 14 point, or whatever number of millimeters you want. If | put it left aligned and
look at the anchoring, remember that we can choose this. [18:56]

Top left here will be perfect, because | just want to put in my address. So let's just go in here. I'll just
click twice and say the address, and then hit the line break, the Enter or Return key, okay. So very
simple to type in text, and of course we can reposition that. Perhaps I'll just grab this and move it a little
bit. So I'll just press down and just move it in a single gesture very quick. Now if | want to fine tune it,
perhaps | want to move it a little bit to get it better lined up, so that looks fine to me. So let's go down
now to the area where we have the client information. And you can see it says, "Project Name". So this
is sort of an odd bit of text, it has a pound sign here. [19:57]

The pound sign refers to a field reference. So just like in a mail merge program, in say Microsoft Word,
it's actually picking up information from a data field. Now, the data fields that this is referring to are
found in the File menu, Info, Project Info. So this is where you can put in information about the project
name or client name, and have it show up for example on the layout sheet. So I'll go in here, and when |
select that command, File, Info, Project Info, you see a little dialog box. And you see it says "Client" is
the name of the field. And now I'll type in say its "John Smith", and project name, "Smith Residence",
and project number, I'll just make one up. And we'll do a company. Now in some versions of ArchiCAD,
you can use the down arrow to go through this. In other cases you may just have to type or click that.
[21:09]



Okay. So I've put in some information, and I'll just say OK. So there's other information you can put in.
You can even create new fields here, and that allows you to put in additional things. | use that often for
consultants and for other information such as the area of the project, or zoning information. Now the
main reason to use these fields is because you can refer to them in a template, and you can refer to
them on multiple layouts. So by putting it in here, we'll see that it actually shows up in more than one
place, rather than just typing it in and manually in a location. So let me say OK, and having done OK, you
can see oh, it says Smith Residence, and all of this information is there. [22:02]

Now the Smith Residence, that text here is a little bit tight, so | can either perhaps change its size, make
it a little smaller, or wait a second, maybe | really want to highlight this, so let me make it bigger. And
when | make it bigger, you'll see how it wrapped. Because this text block has an option that says to
wrap the text. And so that's an option that you can turn on or off, and as long as you have a boundary, in
this case going out to the sides of the available space, the wrap text will work nicely, because it will
actually just expand to be multiple lines. Of course we can drag these things around, and we aren't
seeing a company name. [22:46]

Now if it's a residence, it may not need a company name. But let me just drag this down, and let's see
how we would put in that company name that | had typed in. So to do that, I'll go to the Text tool, and
I'll go put in some text here. In this case, | want to put it in centered, it's and I'll use the center anchor.
Now, when | use a layer in the Layout Book, it's a little bit different, because | want to make sure that
this information doesn't get hidden. Now, in general, you can put it on any layer, and it would work.
But a good tip is to put it on the ArchiCAD layer, because then it will never disappear, it will always stay
visible, because the ArchiCAD layer will never be able to be hidden or is never hidden by ArchiCAD.
[23:34]

Now I'll just click twice to say that I'd like to put in text. Anchor it on this point, and | don't want it to
wrap automatically. Now when | put in this text, | can type it in like | had before, but | can also use this
little A symbol, and in the Auto Text Dialog box, the Insert Auto Text, | can choose the field that | want.
Now there is information that is common to the system, such as what date it is today, or any day that it
has looked at. But | can go into the Project Info, which you recall, when | went to the File menu, Info,
and clicked on the Project Info was the command. And here, | have for example "Company". Say Insert.
And there we go, there's the Company. [24:18]

And | can click outside it to place that. So let's look at how we can do auto text for another thing, say
down near the bottom where we have the Sheet Title. So, the Layout Name, if | select this, if | Shift+click
on it, and I've got the Text tool active, so | can click to edit it, you notice that it's gray. What that means
it is that this is a single unit. | can't actually edit Name, for example, but if | click here, you'll see - well
actually right now it's showing that | can insert some Auto Text. Let me just highlight this. So if | stroke
across it, now it changes from gray to blue, and now if | go to the Auto Text, you'll see it's showing
Layout Name. So Layout Name would be something like "Floor Plans" or "Elevations" or "Detail Sheet"
or something like that. And the ID would be the number. [25:15]



You can see down below that that's going to be the number like "A-101" or something like that. Now, |
don't really need to make a change there. What I'd like to do is click outside it and put in some text
down below. In this case I'll use the same format. In other words, I'll keep it centered, and have it go
out from the center. And in this case I'll type in "Print Date", and then I'll put in a colon and a space, and
instead of typing in what happens to be today, I'm going to use the Auto Text, and switch to the System
option. And then for the system, | can say, oh, let's put in the date long, or the date short, depending on
what you want. I'll just put in the date long here and say Insert. And maybe a little bit too long for that,
so after | place it, if | select it here, | can actually stretch this using the stretch icon, and say | want to fit
this into this area. [26:22]

So I'll just stretch it into position. So now, it's wrapping. | may need to just drag it up a little bit to do
that. So you can see how | can combine, in the same text field here, text that is gray, meeting it's an
automatically filled in field, and text that's manually done that | can go and actually edit. So we can
combine those two. It's a very flexible system. And in fact, that's what happened in this area here.
When | select the address, and | try to stroke through it, you'll see the gray areas are fields. For example
the street address or the city, and then there's the comma and the space; or this other space here are
just some manually placed text to make it work out. [27:12]

So let me just Fit in Window here. And you can see that we've got our title block looking pretty good.
Maybe this we should adjust this down. I'll just select with Shift+clicking all of these elements here, and
perhaps right click, Move, Drag, and take this down a little bit further. So now it looks a little bit better.
Now, let's just take a look at one variation of the masters. If | go to, for example this said "Arch-D". That
is a particular size sheet, and then there's one called "Arch-D plus NCS Grid". So if | double click on that
one, we're going to see something interesting. It's similar looking, and it already has the Smith
Residence and all of that, because those were already on the sheet as references to the data field.
[28:06]

In other words, they were referring to the Project Info. But the other information, for example my
company logo, etc. is not on there. So I'll have to add it manually. And then there's this grid. Let me just
do those two things. I'll go back to the "Arch-D" sheet, and zoom in. And perhaps I'll just get this these
two text blocks on here, and maybe the name of the company, and I'll copy them. And I'll go to the
"Arch-D plus NCS Grid", and I'll Paste. Now when | Paste, if | want it to be in the same location, | would
say "Original Location". So that would put in the same place. In this case I'm slightly cropping the area
where | would see it, so it is offering to possibly put it in the center of the current view. [29:01]

| wouldn't want to do that. | would like to have every sheet look similar, so I'll say Paste here. And you
see it's now moved over to show that. Now, | do have a little bit of a problem, and that is that the name
here is formatted a little differently. | can get rid of these two by just deleting them, hit Delete or
Backspace key. So let me just go back to the Arch-D, and just copy for example these two fields, which |
had moved. And say Copy. And then I'll go back to here and we'll say Paste. And you can see how now
these will be in precisely the same location. [29:46]



So we've established that some things will just show up automatically on different sheets. For example,
if 1 go to a different size sheet like "Arch-F", you can see that it's already got the Smith Residence, etc.,
because that was already on there as a field reference. Whereas the company logo, etc., | would need
to manually paste in and just fit it onto that sheet. Now, let's look at the Grid Settings before we finish
up. And that is that this has a Grid, and you can see some of letters and numbers. If we were to put
detail drawings on here, they would take on the number based on the position on the sheet. And | want
to just show you briefly, this is setup in the settings for the layout master. So Layout Master Settings,
without going into too much detail, you can pick a different sheet sizes here. [30:49]

And there are ones for metric as well as imperial available. And then you can also decide the way that a
grid is set up. And if we have it "Align and Assign Drawings to a Grid", it will have a visible grid. If we use
the other one, it will have it auto arrange drawings, it will not have a visible grid. So with this one, we
have a grid, and if | click on Grid Setup, we'll see some options for how many cells there are in each
direction, and whether they are numbered with 1, 2, 3 or A, B, C etc. There's a lot of variations here that
you can explore. But basically, whatever you have set in this is going to affect not only this particular
master, but any sheet that uses it. And typically the one with the grid, you would have one or several
detail sheets that would refer to it, whereas the other sheets might not have a grid on it. [31:45]

So that's how the master is set up there. So to finish up, we'll take a look at the elevations. And here,
when | go to the elevation sheet that was already existing, we can see that the elevation drawing has a
frame that's much wider than it needs. And we've already explored how you can manually crop that by
adjusting the polygon boundaries. But there is something, once | have this selected, that | can look at
that will automatically fix this. And so it's in the info box, is says "Manually Resize Frame". | can go and
say, Fit Frame to Drawing. So this is a very nice option, because it automatically just brings the
boundaries to the minimum necessary to show the entire drawing. And I'll just move this elevation over
to the side here. [32:36]

Now I'd like to combine the other elevations. Obviously with this small project, maybe | just want to put
all four of the elevations on one sheet. So let me just drag these on here. And as | do this, you'll see
some things show up onscreen. But you'll notice that we're not actually seeing those drawings come up.
Why? Because those drawings in this particular project have never been looked that, so we're seeing
the last update of it, which of course it had never been updated, and the building was constructed since
then. So, what we need to do is to tell ArchiCAD to update these drawings. Now I'm going to go and
select all of the drawings on the sheet. You can see here's the Drawing tool in the toolbar. And | can go
and select all drawings by doing Command or CTRL+A or using this menu command. And that selects all
of them. And | can right click in empty space or in any one of them and say "Update". This will request
ArchiCAD to update all of those drawings. [33:47]

And you'll see within a few seconds, we'll start to see some more information drawn. In the upper right
corner, you can see the drawing update here. I've just moved it down a little bit so you can see it. And
now we can see all of those drawings appear. Now normally when you reorganize drawings onto a
sheet, you're going to already have something to look at. But in this special case, because | had moved
drawings that had never been updated, never been viewed, they appeared blank. Now, you notice that



the boundary for of the first drawing that | had looked at has already been reconfigured. But for the
other ones, it hasn't been. In other words, there still floating in space bigger than they need to be.
[34:30]

So with them all selected, I'll go here and say that I'd like to switch the frame to fit frame to drawing. So
this will set all the ones that were not set to that to fit automatically to the drawing. So that actually
was a very convenient thing. | can move this around in whatever order | like. So | can grab, press down
and move, grab, press down and move here. And of course | probably would want to make sure that the
base of this one and the base of that one are in line. So again, if | go from this bottom corner, and | say |
want to move it and | take it up, press the Shift key, then | can move the cursor left or right, and | can
just get the checkmark on the other one. And now these are perfectly aligned. [35:19]

Actually let's just see here, if | grab this and move it down, if press this and click; now they are perfectly
aligned. So you have to make sure that you are snapping on the right point. And I'll just grab this, I'll
press down, start to move from that corner, I'm line this up here. And now, at least | know that
vertically these drawings coordinate properly. So one final note before we conclude this. These
elevations came out pretty quickly, just within a few seconds. But if you have a more complex project, it
may take awhile to bring up the individual elevation or certainly a sheet of several elevations. So, you
may not want to always have it update every time that you go to the sheet. [36:02]

These sheets are set up right now, the drawings are set up to automatically update. And how do | know
that? Well I just know that that's the setup for the standard template that Graphisoft provides. But let's
take a look. If | select this drawing, and | open up its settings by clicking on the icon in the Info palette,
you'll see that there's an update type "Auto" or "Manual" that we can choose. And so if | change that to
Manual, than what will happen is that this drawing will not be updated until | manually click that green
button over on the right side, or | right click on it and say "Update Drawing". So why would you do that?
Well if it takes a long time to update those drawings, and you're flipping through the sheets just look at
stuff quickly, then perhaps you would want to turn one or more of the drawings in your Layout Book to a
Manual update, so that you can control when ArchiCAD takes the time to update them. So this is really
optional, but if you have a very large project it may be useful for you. [37:13]

So this concludes our training on the Layout Book and bringing views as drawings onto the layout sheets.
This has been Eric Bobrow. Please share your comments and questions on the page down below the
video. Thanks for watching. [37:28]



